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Discovery Question

When two objects hit, is the force on one the same as the force on the other?

Introduction

In this activity you will investigate what happens during a collision between two
carts.
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Thinking About The Question

When two objects hit, is the force on one the same as the force on the other?

Suppose two identical balls bounce off of each other. Does each one experience
the same force? Will they each bounce off with the same velocity they started with?
Explain your reasoning in Notes on your handheld computer.

In your group, predict and explain what happens when two objects with different
masses, like a heavy and a light ball or a heavy truck and a small car collide. Is the
force on each one the same? What is the resulting motion of each object? Write or
draw in Notes on your handheld computer your ideas about what might explain your
predictions.
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Materials

• CC SmartWheel probe

• CC Force probe

• handheld computer

• CC LabBook software

• 2 - long rubber bands (so they have a length of about 30cm when cut)

• constructed air carts (see Investigation: Air Cart)

• hot-melt (or cold-melt) glue gun and glue sticks

• paper clip

• pencil or pen
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Safety

• Be careful with stretched rubber bands. They can hurt if you let them go and
they hit someone!
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Trial I: Action and reaction

1. Cut two rubber bands and tie them together to make a bungee cord about 30
cm long.

2. Team up so that each group has two Force probes. Attach one end of the
bungee to one Force probe, and the other end to the other Force probe. Use
the small eyebolt to attach the rubber bands.

3. Connect each Force probe to its own handheld computer. Refer to Technical
Hints to see how to connect the cables.

4. Each team member will pull on one of the Force probes, much like a
tug-of-war. When do you think the two force graphs will be the same? When do
you think the two force graphs will be different? Record your prediction in Notes
on the handheld computer.

5. Start the software for each Force probe.

6. Set the force probe to zero. Refer to Technical Hints to see how to set the Force
probe to zero.

7. Start recording. Vary the amount of pulling, who pulls first, and who doesn't
move.

8. Save your data to the handheld computer.

9. Compare the graphs from the two force probes. What can you conclude?
Was your prediction correct? Record your thoughts in Notes on your handheld
computer.
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Trial II: Forces on colliding carts

1. Screw one Force probe to each cart, so that the eye bolt points forward. You
will need to remove the bumper and the acrobat to do this.

2. Set the Force probe on the cart, resting on the flat plate that has two threaded
holes in it. Mark the two holes on the cardboard with a pen or pencil.

3. Punch two holes in the cardboard with your pen or pencil. Enlarge them from
both sides so that a screw will just fit through.

4. Put the two screws first through the cardboard from the underside, and then
screw them into the Force probe plate. Tighten them until the heads squeeze
the cardboard a little bit. A paper clip will work as a screwdriver.

5. Unscrew the larger eyebolt and set it aside. Glue the bumper on the smaller
eyebolt.
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6. Connect the Force probe to your handheld computer. Refer to Technical Hints
to see how to connect the cables.

7. Predict what the force graphs will look like if you roll the two carts toward
each other. What if they have about the same velocity? What if you roll one cart
toward the other which is not moving? Record (or draw) your predictions in
Notes on the handheld computer.

8. Start the software. Set the force probe to zero. Refer to Technical Hints to see
how to set the Force probe to zero. Weigh each cart by hanging it from the
small eyebolt.

9. Make the carts equal in mass by adding some clay to one of them if needed.

10. With the carts horizontal, set each Force probe to zero. Refer to Technical Hints
to see how to set the Force probe to zero.

11. Start recording. Push the carts toward each other at about the same velocity,
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and let them bounce back.

12. Try this again several times. When you get a good run, save your data to the
handheld.

13. Look at the force graphs for both teams. Were they the same for both carts?
How long did the collision take? What was the maximum force? Record your
observations in Notes on your handheld computer.
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Trial III: Velocities of colliding carts

1. Each team should connect the SmartWheel to their handheld computer. Refer
to Technical Hints to see how to connect the SmartWheel.

2. Predict what the velocity graphs will look like if one cart is stationary and you
roll the other cart against it. What will be the velocity for each cart before and
after the collision? What will the velocity graph do just at the moment of
collision? Draw your predictions in Notes on the handheld computer.

3. Start the software to record a velocity versus time graph.

4. Start recording. Push one cart toward the other and let them bounce. Be sure
the bumpers are lined up.

5. Try this again several times. When you get a good run, save your data to the
handheld.

6. Look at the velocity graphs for both teams. Were they what you predicted?
How did the initial velocity of one cart compare with the final velocity of the
other? Draw the velocity graph for each cart, and write in the velocity values.
Record your drawings and thoughts in Notes on your handheld computer.
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Technical Hints

Connecting the Force probe

1. Connect the flexible cable from the Force probe to the Force probe card. Plug
the Force probe card into Port A of the Interface Box. Be careful not to bend any
of the copper prongs, or it won't work.

2. Attach the CCProbe Interface Box to your handheld with the Velcro square.
Connect the CCProbe Interface Box to your handheld with the provided
connector cable.

3. Tap on the CCProbe icon to open the software. Open or create a Force probe
data collector.
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Setting the Force probe to zero

1. Connect the Force probe to the CCProbe Interface and open the CCProbe
software. Open a Force data collector. Hold the Force probe in the exact
position and orientation where you would like it to read zero.

2. At the bottom of the screen, click on the Tools menu.

3. Click on Zero Force Probe in the Tools menu.

4. The Force probe will be set to zero. Wait a few seconds and then go ahead with
collecting data.
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Connecting the SmartWheel

1. Connect the flexible cable from the SmartWheel to the SmartWheel card. Plug
the SmartWheel card into Port A of the Interface Box. Be careful not to bend
any of the copper prongs, or it won't work.

2. Attach the CCProbe Interface Box to your handheld with the Velcro square.
Connect the CCProbe Interface Box to your handheld with the provided
connector cable.

3. Tap on the CCProbe icon to open the software. Open or create a SmartWheel
data collector. Choose either the linear position or the linear velocity mode.
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Using the CC LabBook software

To use CC LabBook just follow these easy steps!

1. Opening the software

a. To open the software, tap the CCProbe icon.

b. The first screen you see is the LabBook.

2. Opening folders and subfolders

a. The LabBook lists all of the folders, data collectors, notes, saved datasets,
and other objects in the LabBook. To open folders and subfolders, tap the
triangles or double-tap the folder name.
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b. Click Home (upper left) to go back to the top level folder.

3. Opening a data collector

a. To take data with a CC probe, you must open or create a data collector. In
these investigations, the data collectors have already been created.

b. To open an existing data collector, highlight its name, then tap it twice or
tap Open. It may take a few seconds for the graph to appear.

4. Collecting and clearing data
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a. To start collecting data, tap Collect.

b. As data is collected, the current values appear at the top of the graph. To
stop collecting, tap Collect again.

c. You can clear the data with Clear, and then continue collecting data with
Collect.

5. Reading graph values

a. To read values of a graph once it has been collected, tap on the Mark flag
and tap where you want to read the value.
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b. A little triangle will appear, connected to crossed lines. The mark can be
moved around with the cursor, and the x and y values of the graph will
show at the top.

6. Recognizing collection limits

Currently there is a limit to how much data can be collected at once, about
4000 data points. The collecting will stop when this amount is reached, so plan
your experiments with this in mind. In terms of time, the limits are as follows:

Force probe, 400/sec = about 7 seconds

Force probe, 200/sec = about 15 seconds

SmartWheel = about 40 seconds

All others 3/sec = several minutes

7. Scrolling around the graph

To scroll around the graph, tap and drag within the graph area itself. There
may be a slight delay before the graph responds.

8. Changing the scale of an axis

a. To change the scale of an axis, tap and drag on the region along the axis.
Drag away from zero to expand the scale and toward zero to shrink the
scale. There may be a slight delay before the graph responds.
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b. If you stretch or shrink the scale a great deal, it will switch by a factor of
1000, shown as 10^3 (for large numbers) or 10^-3 (for small numbers). For
example, in the following screen, time is in milliseconds (1/1000 of a
second) and light intensity is in kilolux (1000 lux).

9. Zooming in on the graph

a. To zoom in on part of a graph, tap on the area selector at the bottom of
the screen.

b. Drag the outline around the area of the graph you want to zoom in on,
then tap Tools.
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c. Click Zoom in the Tools list.

d. The graph will reappear showing just the area you selected.

10. Changing graph properties

a. To change graph properties, tap the Palm menu icon at the bottom left
corner, then the Edit menu item. Tap Graph Properties.
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b. To change the title, go to the Graph tab. Write the new title, and then tap
OK.

c. To change the range and the label of an axis, tap on the YAxis or XAxis
tab. Write in the Max, the Min, and the Label, and then tap OK.

d. Another method of changing the range and the label of an axis is to tap on
the ends of axes to open graph properties.
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11. Saving data

a. To save your data, tap the Palm menu icon at the bottom left corner. Then
tap Save Data in the File menu. The menu will disappear when the data is
saved. This may take several seconds.

b. When prompted, give your data set a name. It will be saved in your
LabBook.

12. Closing the data collector

To close the data collector and go back to the LabBook screen, tap Done.
Your data will NOT automatically be saved.
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Analysis

1. Trials I and II are examples of Newton 's famous assertion that "for every
action, there is an equal and opposite reaction." Does it seem to be true in both
cases? Is the result surprising?

2. If you were pushing on each other with Force probes instead of pulling, would
they still read the same?"

3. If one of the Force probes were attached to a wall and you were pulling on
the other one, would they read the same force?

4. If a light cart hit a heavy cart at rest, what would you say now about the force
on each one and their speeds after the collision?

5. Newton's Second Law asserts that a force is needed to change the velocity of
an object. The greater the force, the more quickly the velocity changes.
Describe an experiment to test this theory.
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Further Investigations

• Try other collisions: one cart moving and the other standing still; both moving in
the same direction, one fast and one slow; both moving toward each other, one
fast and one slow. In each case, make a prediction about the final velocities and
then compare the results to your prediction.

• Try collisions between carts of different masses. First record the force on each.
Are the forces the same? Then record the velocity of each. How did the change
in forces and velocities after the collisions for carts of different masses compare
to the forces and velocities after the collisions for carts of the same mass?

TEEMSS:Collision II

Copyright © 2001 The Concord Consortium, All rights reserved. p. 23


